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Quick Start

 

This guide covers three types of storage for 
Pro Tools systems: stand-alone SCSI drives, 
SCSI-based MediaDock systems, and FireWire 
drives.

This chapter includes quick start instructions for 
installing each type of storage. Complete instal-
lation and operation instructions are provided 
in the remainder of this guide. 

 

SCSI Drives and MediaDock 
Systems

 

Installing a SCSI Drive

 

If you are installing a standalone Avid SCSI 
drive, start by connecting the SCSI drive to your 
computer:

 

To connect a SCSI drive:

 

1  

 

Shut down your computer.

 

2  

 

Connect the AC power cord to the drive.

 

3  

 

Connect a SCSI cable between the SCSI host 
bus adapter (HBA) in the computer and either of 
the connectors on the SCSI drive. 

 

4  

 

Make sure the SCSI chain is properly termi-
nated. If the SCSI drive is last in the SCSI chain, 
connect a SCSI terminator to the second con-
nector on the SCSI drive.

 

5  

 

Set the SCSI ID on the drive to a unique num-
ber. Do not use ID 7, which is reserved for the 
SCSI HBA.

 

6  

 

Turn on your SCSI drive, then turn on your 
computer.

 

7  

 

Continue with “Initializing a SCSI Drive” on 
page 2. 

 

Installing a MediaDock Chassis

 

If you are installing an Avid MediaDock chassis, 
start by connecting the chassis to your com-
puter, then inserting a MediaDock shuttle drive 
in the chassis. 

 

To connect a MediaDock chassis:

 

1  

 

Shut down your computer.

 

2  

 

Connect the AC power cord to the chassis.

 

3  

 

Connect a SCSI cable between your system 
and the appropriate SCSI connector on the chas-
sis. 

 

4  

 

Make sure the SCSI chain is properly termi-
nated. If the MediaDock chassis is last in the 
SCSI chain, connect a SCSI terminator to the ap-
propriate SCSI connector on the chassis.

 

5  

 

Insert a MediaDock shuttle in the chassis by 
opening the top handle on the shuttle, inserting 
the drive into an available drive bay, and closing 
the top handle.
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6  

 

Set the SCSI ID on the MediaDock shuttle to a 
unique number. Do not use ID 7, which is re-
served for the SCSI HBA. 

 

7  

 

Turn on the MediaDock chassis, then turn on 
your computer.

 

8  

 

Continue with “Initializing a SCSI Drive” on 
page 2. 

 

Initializing a SCSI Drive

 

Before you can use a SCSI drive for recording, 
you need to initialize the drive for your com-
puter’s operating system.

 

Windows

 

Initialize the SCSI drive with the Windows XP 
Disk Management Tool. Choose NTFS as the File 
System. 

 

Mac OS X

 

Initialize the SCSI drive with the Mac OS X Disk 
Utility. Choose Mac OS Extended (HFS+) as the 
File System. 

 

Mac OS 9

 

Initialize the SCSI drive with the ATTO Ex-
pressPro-Tools application (included on the 
Pro Tools Installer CD-ROM). Choose Mac OS 
Extended (HFS+) as the File System. 

If you are running Mac OS 9, do not use the Dig-
ital Audio mode page settings in ATTO Ex-
pressPro-Tools. In the next step, you will use 
DigiDriveTuner to set the optimal mode pages 
for use with Pro Tools on Mac OS 9. 

 

Tuning a SCSI Drive

 

After initializing a SCSI drive, you should tune 
the drive using the supplied utility software for 
your operating system.

 

Windows XP and Mac OS X

 

Install the DigiDrive Storage Manager applica-
tion from the CD-ROM included with the drive. 

Launch the DigiDrive Storage Manager applica-
tion and click Tune. This optimizes the mode 
pages of all connected Avid and Digidesign SCSI 
drives for use with Pro Tools.

 

Mac OS 9

 

Locate the DigiDriveTuner application on the 
CD-ROM included with the drive, and drag it to 
the Pro Tools Utilities folder on your system 
drive. 

 

When formatting SCSI drives larger than 
60 GB for use on a Macintosh, use the HFS+ 
file system. If you must use regular HFS, you 
should partition the drive so that each par-
tition is 69,695 MB or less. Otherwise, you 
will not be able to transfer files over 2 GB in 
size. 

DigiDrive Storage Manager only works on 
Avid and DigiDrive SCSI drives. It does not 
affect FireWire drives, or drives from other 
manufacturers.
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Launch the DigiDriveTuner application. When 
DigiDriveTuner detects a SCSI drive, it will auto-
matically optimize the drive’s mode pages for 
use with Pro Tools.

 

FireWire Drives

 

To set up your FireWire drive for use with 
Pro Tools, you must connect it to your com-
puter, then format it for your computer’s oper-
ating system.

 

Installing a FireWire Drive

 

First, connect the FireWire drive to your com-
puter.

 

To connect a FireWire drive:

 

1  

 

Connect the AC power cord to the drive. 

 

2  

 

Connect the 6-pin FireWire cable between 
your system and either of the FireWire connec-
tors on the FireWire drive.

 

Intializing a FireWire Drive

 

Before you can use a FireWire drive for record-
ing, you need to initialize the drive for your 
computer’s operating system.

 

Windows

To initialize a FireWire drive for WIndows:

 

1  

 

Open the Windows Disk Management Utility. 

 

2  

 

Select Basic disk type. 

 

3  

 

Select Primary as the partition. 

 

4  

 

Select NTFS as the File System. 

 

5  

 

Select Perform Quick Format. 

 

6  

 

Type a name for the drive partition and click 
Next.

 

Macintosh

To initialize a FireWire drive for Mac OS X:

 

1  

 

Turn on the FireWire drive. 

 

2  

 

Launch the Disk Utility application, located in 
the Utilities folder inside the Applications 
folder.

 

3  

 

Click the Erase tab. 

 

4  

 

Select the drive you want to initialize in the 
column on the left side of the window. 

 

5  

 

Choose the format for the drive, and type a 
name for the volume. 

 

6  

 

Click Erase. 

 

To initialize a FireWire drive for Mac OS 9:

 

1  

 

Turn on the FireWire drive. An initialization 
dialog appears in the Finder.

 

2  

 

Select HFS+ from the Format menu.

 

3  

 

Type a name for the FireWire drive and click 
Initialize.

 

4  

 

Click Continue. 

 

DigiDriveTuner only works on Avid and 
DigiDrive SCSI drives. It does not affect 
FireWire drives, or drives from other manu-
facturers.

 Be sure to insert the FireWire cable connec-
tor in the correct direction. Inserting the 
connector upside down can damage the 
FireWire bus on the computer.
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SCSI Drive Installation

 

Connecting SCSI Drives

 

This section covers connection of SCSI drives to 
Pro Tools systems. For information on initializ-
ing SCSI drives, refer to Chapter 5, “Drive Man-
agement for Windows XP” or Chapter 6, “Drive 
Management for Macintosh.”

 

SCSI Cable Requirements

 

Use only high-quality LVD SCSI cables when 
you are attaching a SCSI drive to the SCSI bus on 
your system.

The following instructions are for connecting 
SCSI drives to any supported dual-channel SCSI 
host bus adapter (HBA) card installed in the 
computer.

 

To connect SCSI drives:

 

1  

 

Turn off power to both the computer and the 
SCSI drive.

2  Attach a SCSI cable from either connector on 
the SCSI drive to a SCSI port on the SCSI HBA 
card in the computer. If you are only using one 
cable, connect it to the port labeled Channel 1.

3  Connect additional drives according to the 
type of media they will be storing: 

• If you will be working with audio only, 
connect an equal number of audio drives to 
each of the two channels on the SCSI HBA 
card.

• If you are working with both audio and 
video files, connect all audio drives to one 
channel on the SCSI HBA card, and all 
video drives to the other channel. 

For more information on SCSI cables, see 
Appendix A.

Dual-Channel SCSI host bus adapter connectors

SCSI cable to SCSI drive connection

CHANNEL 1 CHANNEL 2

Avid Drive

68-pin SCSI cable from computer's SCSI 
host bus adapter
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4  To daisy-chain SCSI drives, use a SCSI cable to 
attach the remaining connector on the first SCSI 
drive to a connector on the second SCSI drive. 

5  Attach a SCSI terminator to the remaining 
connector on the last SCSI drive in each drive 
chain.

6  Attach an AC power cord to the AC power 
connector on the back of each drive.

Connecting Different SCSI 
Drive Types
You can mix Avid drives along with other wide 
drives, as well as with narrow drives, on the 
same SCSI bus. This allows you to continue us-
ing your narrow drives as you expand your sys-
tem’s storage capability. 

When mixing wide drives and narrow drives on 
the same SCSI bus, the following conditions ap-
ply:

◆ Mixing an ultra-wide LVD drive with either a 
single-ended wide or a narrow drive on an LVD 
bus causes the bus to default to single-ended 
mode. When you mix drive types, cable length 
restrictions for single-ended SCSI chains apply.

◆ Place the wide (68-pin) drives physically on 
the SCSI bus before the narrow (50-pin) drives. 

◆ PCI-based SCSI buses that contain a mixture 
of wide and narrow drives can have up to eight 
drives on the SCSI bus.

◆ To connect a 50-pin narrow SCSI drive to a 
68-pin SCSI port or cable, use a wide-to-narrow 
terminating adapter (68-pin to 50-pin) for the 
connection between the last wide drive and the 
first narrow drive. The adapter terminates un-
used data lines in the cable to ensure data integ-
rity on the SCSI bus.

The following instructions are for connecting a 
mix of wide and narrow SCSI drives to a system 
that also includes Avid SCSI drives.

Additional SCSI drive connection

Ultra, Wide SCSI terminator connection

Avid Drive

68- pin to 68-pin 
15-inch SCSI cable

68-pin SCSI cable from computer's SCSI 
host bus adapter or other drives

Avid Drive
Ultra-wide SCSI terminator

68-pin SCSI cable from computer's SCSI 
host bus adapter or other drives
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To connect wide and narrow drives:

 

1  

 

Connect any Avid SCSI drives to your system 
first.

 

2  

 

Connect other wide drives second. Use a 68-
pin to 68-pin SCSI cable to attach the remaining 
SCSI connector on the last Avid drive in the 
drive chain to a SCSI connector on the wide 
drive. 

 

3  

 

Daisy-chain any additional wide drives to the 
first wide drive.

 

4  

 

Connect narrow drives last. Locate an ultra 
wide-to-narrow SCSI adapter. The adapter has a 
68-pin female connector on one end and a 50-
pin Centronics

 

®

 

 connector on the other end.

 

5  

 

Attach the wide-to-narrow SCSI adapter to the 
first narrow drive.

 

6  

 

Use a 68-pin to 68-pin SCSI cable to attach the 
remaining SCSI connector on the last wide drive 
in the drive chain to the wide-to-narrow SCSI 
adapter. 

 
7  

 
Daisy-chain any additional narrow drives to 

the first narrow drive using cables with 50-pin 
Centronics connectors on both ends.

 

Additional wide drive connection

4

 
Avid Drive

Wide drive

68- pin to 68-pin 
15-inch SCSI cable

68-pin SCSI cable from computer's SCSI 
host bus adapter or other drives

 

SCSI cable to narrow drive connection

Additional narrow drive connection

0
+   

68- pin SCSI connector

Narrow Drive

Wide-to-narrow
SCSI adapter

Bail-latches

0
+   

0
+   

50- pin to 50- pin

Narrow

68- pin SCSI cable 

Narrow

from drives

SCSI cable

Drive

Drive
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8  

 

Attach a 50-pin SCSI terminator to the re-
maining SCSI connector on the 

 

last

 

 narrow 
drive in each drive chain.

 

9  

 

Attach an AC power cord to the AC power 
connector on the back of each drive.

 

Connecting a MediaDock 
Chassis

 

The following instructions are for connecting a 
MediaDock II chassis to any supported dual-
channel SCSI host bus adapter (HBA) card in-
stalled in the computer.

 

To connect a MediaDock chassis:

 

1  

 

Turn off power to both the computer and the 
chassis.

 

2  

 

Attach a SCSI cable to a SCSI port on the SCSI 
HBA card in the computer. If you are only using 
one channel, connect it to the port labeled 
Channel 1. 

 

3  

 

Connect the other end of the SCSI cable to the 
SCSI port on the first bay of the MediaDock 
chassis. 

 

4  

 

If you have two MediaDock shuttle drives in-
stalled in the MediaDock, and are using a single 
SCSI channel, connect the other SCSI port on 
the first bay and to a port on the second bay (see 
Figure 1 on page 9).

– or –

If you have two MediaDock shuttle drives in-
stalled in the MediaDock, and are using both 
SCSI channels, repeat steps 2–3 to connect the 
second SCSI bus to channel 2 of the SCSI HBA 
(see Figure 2 on page 9).

 

5  

 

Connect additional MediaDock chassis and 
shuttle drives according to the type of media 
they will be storing:

• If you will be working with audio only, 
connect an equal number of shuttle drives 
to each of the two channels on the SCSI 
HBA card.

• If you are working with both audio and 
video files, connect all audio drives to one 
channel on the SCSI HBA card, and all 
video drives to the other channel. 

You can daisy-chain up to four MediaDock chas-
sis (containing eight MediaDock shuttles) on a 
single SCSI bus. 

Figure 3 illustrates four MediaDock chassis on a 
single SCSI channel, and Figure 4 illustrates four 
MediaDock chassis on two SCSI channels.

 

6  

 

Attach a SCSI terminator to the remaining 
connector on the last SCSI drive in each drive 
chain.

 

Ultra,-narrow SCSI terminator connection

Dual-Channel SCSI HBA connectors

0
+   

Narrow

50- pin SCSI connector

Ultra, narrow SCSI terminator

Drive

CHANNEL 1 CHANNEL 2
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\

 
Figure 1.  Single MediaDock chassis, single-channel SCSI with termination

SCSI cable

SCSI terminator

SCSI 
cable to SCSI HBA

 

Figure 2.  Single MediaDock chassis, dual-channel SCSI connections with termination

SCSI terminator

 SCSI 
cable to SCSI HBA
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Figure 3.  Configuration using four MediaDock chassis, single channel SCSI connections with termination

 

SCSI terminator

SCSI cable
to SCSI HBA

SCSI cables
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\

 

Figure 4.  Configuration using four MediaDock chassis, dual-channel SCSI connections with termination

 

SCSI terminator

SCSI cables

SCSI cables
to SCSI HBA
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Assigning SCSI IDs

 

SCSI ID Requirements

 

Your system identifies the SCSI drives con-
nected to the SCSI bus by the drive’s assigned 
SCSI ID. When you are assigning SCSI IDs to the 
drives, the following conditions apply:

 ◆  Each device on each SCSI bus, including the 
system SCSI accelerator board, must have a 
unique SCSI ID. 

 

◆

 

SCSI ID 7 is reserved for each SCSI accelerator 
board in your system. Do not assign SCSI ID 7 to 
a SCSI drive.

 

◆

 

Narrow (50-pin) SCSI drives can only use SCSI 
IDs 0 through 6.

 

◆

 

Wide (68-pin) SCSI drives, including Avid 
drives, can use SCSI IDs 0 through 6 and 8 
through 15. 

 

Avoiding SCSI ID Conflicts

 

When you add a new drive to your system, 
check which SCSI IDs are currently in use. As-
signing duplicate SCSI IDs can cause problems 
such as system errors, the drive not appearing 
on the desktop, multiple copies of the same 
drive appearing on the desktop, possible data 
corruption, or system startup failures.

Digidesign recommends that you set the SCSI 
IDs for the devices on each SCSI bus in sequen-
tial order, that is, starting with the device at-
tached closest to the Digidesign system as ID 0.

 

To set a SCSI ID:

 

1  

 

Turn off the computer, and make sure the SCSI 
drive or MediaDock power is off. 

 

2  

 

Locate the SCSI ID switch on the front of the 
SCSI drive or MediaDock chassis.

 

3  

 

Set the SCSI ID to an available SCSI ID on the 
SCSI bus by pressing the buttons on the SCSI ID 
switch. 

There are two versions of SCSI ID switch used 
with Avid drives. One version uses the numbers 
0 through 15, and the other version uses the 
numbers 0 through 9 and the letters A through 
F. Use the table below to associate the letters A 
through F with a SCSI ID number.

 

4  

 

Turn on the SCSI drives or MediaDock and 
start the computer. The drive will appear on the 
system with the new SCSI ID. 

 

Do not set the SCSI ID for any drive on any 
SCSI bus to SCSI ID 7. This can prevent the 
drive from mounting on the desktop, or pre-
vent your Digidesign system from starting 
up correctly.

 

SCSI ID Switch

Numbers Associated with SCSI Switch Letters

 

Switch Letter SCSI ID Number

 

A 10

B 11

C 12

D 13

E 14

F 15

2
-

+

Decrement ID

Increment ID

Current SCSI ID
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SCSI Termination

 

Your computer’s SCSI chain must be properly 
terminated or your system will not function cor-
rectly. Connect an LVD SCSI terminator to the 
last drive on each SCSI bus.

The drive should use either an external termina-
tor plug or have its internal terminator enabled. 
(Avid drives do not use internal termination.) If 
you are using an external terminator, Digidesign 
recommends that you use only the highest qual-
ity active SCSI terminator to ensure data integ-
rity.

 

Disconnecting SCSI Drives

 

When you disconnect a SCSI drive, you first 
need to turn off the computer and all SCSI 
drives. 

 

To disconnect a SCSI drive:

 

1  

 
Quit Pro Tools. 

 
2  

 Turn off the computer. 

3  

 

Turn off all the SCSI drives connected to the 
system.

 

4  

 

Disconnect the SCSI drive.

 

5  

 

Reconnect any remaining SCSI drives and 
make sure the SCSI chain is properly termi-
nated.

 

For more information on SCSI terminators, 
see Appendix A.

Do not enable internal termination and in-
stall an external terminator plug on the 
same drive. This will cause SCSI errors. See 
your hard drive’s documentation for infor-
mation on the type of termination it uses. 
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Inserting a MediaDock 
Shuttle

 

Each MediaDock chassis provides shuttle bays 
for two MediaDock shuttles. This section ex-
plains how to install a MediaDock shuttle in the 
MediaDock chassis. 

Each MediaDock shuttle has two handles. The 
bottom handle is stationary, while the top han-
dle can be pulled outward from the left of the 
MediaDock shuttle by pressing a latch on the in-
side of the handle (see Figure 5). When you 
close the top handle with the MediaDock shut-
tle partially in the MediaDock chassis, the lever 
catches the chassis and gently connects the Me-
diaDock shuttle into the MediaDock backplane.

 

To install a MediaDock shuttle:

 

1  

 

Carefully align the MediaDock shuttle in front 
of the empty bay.

 

2  

 

Pull the top handle outward to the open posi-
tion.

 

3  

 

Insert the MediaDock shuttle into the bay and 
gently push until you feel the contact with the 
inside of the MediaDock chassis.

 

4  

 

Gently but firmly close the top handle. 

The MediaDock shuttle will automatically spin 
up when power is applied to the MediaDock 
chassis. If the MediaDock chassis is already pow-
ered up and you insert a MediaDock shuttle, the 
shuttle will spin up as soon as it is fully latched 
into the MediaDock chassis.

 

Figure 5.  MediaDock Shuttle latch and handles

Lever

Bottom handle

Top handle

Latch

 

Inserting the MediaDock shuttle
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Replacing a MediaDock 
Shuttle

 

You can remove the shuttle in several different 
ways, depending on your operating system, the 
utilities available to you, and whether the com-
puter is on. 

To make sure the operating system can see the 
replacement MediaDock shuttle in the system, 
use this 

 

general procedure

 

:

 

To remove a MediaDock shuttle on any system:

 

1  

 

Identify the MediaDock shuttle you want to 
remove.

This can be done by accessing the MediaDock 
shuttle and watching the activity LED on the 
shuttles.

 

2  

 

Make sure you are not accessing the Media-
Dock shuttle.

 

3  

 

Shut down your computer. (It is not necessary 
that you turn off the MediaDock chassis.)

 

4  

 

Release the latch and open the handle on the 
shuttle to disengage the shuttle from the back-
plane.

 

5  

 

Allow the drive to spin down. Wait 30 seconds 
before fully removing the shuttle to ensure that 
heads are parked. 

 

6  

 

Insert the new MediaDock shuttle as ex-
plained in “Inserting a MediaDock Shuttle” on 
page 14.

 

7  

 

Allow the MediaDock shuttle to spin up. This 
typically takes less than 30 seconds. 

 

8  

 

Turn on (or reboot) your computer. The new 
MediaDock shuttle can be seen by the operating 
system.

 

Figure 6.  Letting the MediaDock Shuttle spin down
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WarmSwapping a MediaDock 
Shuttle

 

You can also 

 

WarmSwap 

 

MediaDock shuttles in 
and out of a MediaDock chassis. WarmSwap-
ping refers to the process of unmounting a 
drive, replacing it, and mounting the new drive 
without shutting down your computer and 
while the MediaDock power is still on.  

Windows

 

To WarmSwap a MediaDock shuttle in Pro Tools 6 
and higher:

 

1  

 

Choose Windows > Show Workspace. 

 

2  

 

Select a drive (volume) in the Workspace 
browser. 

 

3  

 

Choose Unmount from the Browser menu. 

 

4  

 

Release the latch and open the handle on the 
shuttle to disengage the shuttle from the back-
plane (see Figure 6 on page 15).

 

5  

 

Allow the drive to spin down. Wait 30 seconds 
before fully removing the shuttle to ensure that 
the heads are parked. 

 

6  

 

Remove the MediaDock shuttle.

 

7  

 

Insert the new MediaDock shuttle and allow it 
to spin up. This can take up to one minute.

 

8  

 

Assign a drive letter to the new MediaDock 
shuttle.

The new drive automatically appears in the 
Workspace browser. 

 

To WarmSwap a MediaDock shuttle in 
Pro Tools 5.x and lower:

 

1  

 

Quit Pro Tools.

 

2  

 

Right-click the My Computer icon and choose 
Manage from the pop-up menu.

 

3  

 

Select Disk Management.

 

4  

 

In the Disk Management tool window, choose 
Action > All Tasks > Change Drive Letter and 
Paths.

 

5  

 

Click Remove. The disk is unmounted.

 

6  

 

Release the latch and open the handle on the 
shuttle to disengage the shuttle from the back-
plane (see Figure 6 on page 15).

 

7  

 

Allow the drive to spin down. Wait 30 seconds 
before fully removing the shuttle to ensure that 
the heads are parked. 

 

8  

 

Remove the MediaDock shuttle.

 

9  

 

Insert the new MediaDock shuttle and allow it 
to spin up. This can take up to one minute.

 

10  

 

In the Disk Management tool, choose Action 
> Rescan Disks. 

 

11  

 

Assign a drive letter to the new MediaDock 
shuttle.

 

Before you change any MediaDock shuttle, 
be sure to unmount the drive. Failure to un-
mount the drive can cause damage or data 
loss.
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Macintosh

 

To WarmSwap a MediaDock shuttle in Pro Tools 6 
and higher:

 

1  

 

Choose Windows > Show Workspace. 

 

2  

 

Select a drive (volume) in the Workspace 
browser. 

 
3  

 
Choose Unmount from the Browser menu.

 
4  

 
Release the latch and open the handle on the 

shuttle to disengage the shuttle from the back-
plane (see Figure 6 on page 15).

 

5  Allow the drive to spin down. Wait 30 seconds 
before fully removing the shuttle to ensure that 
the heads are parked. 

6  Remove the MediaDock shuttle.

7  Insert the new MediaDock shuttle and allow it 
to spin up. This can take up to one minute.

8  Scan the SCSI bus using ATTO ExpressStripe or 
any other SCSI utility to identify and mount the 
new drive.

The new drive automatically appears in the 
Workspace browser. 

To WarmSwap a MediaDock shuttle in Pro Tools 5 
and lower:

1  Quit Pro Tools. 

2  Unmount the drive by dragging its icon on 
the Desktop to the trash.

3  Release the latch and open the handle on the 
shuttle to disengage the shuttle from the back-
plane (see Figure 6 on page 15).

4  Allow the drive to spin down. Wait 30 seconds 
before fully removing the shuttle to ensure that 
the heads are parked. 

5  Remove the MediaDock shuttle.

6  Insert the new MediaDock shuttle and allow it 
to spin up. This can take up to one minute.

7  Scan the SCSI bus using ATTO Express-
Pro Tools, ATTO ExpressStripe, or any other 
SCSI utility to identify and mount the new 
drive.
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chapter 3

FireWire Drive Installation

Connecting FireWire Drives
This section covers connection of FireWire 
drives. For information on initializing FireWire 
drives, refer to Chapter 5, “Drive Management 
for Windows XP” or Chapter 6, “Drive Manage-
ment for Macintosh.”

FireWire Cable Requirements

The FireWire cable between the computer and 
the first drive (or between any two ports) cannot 
exceed 14.76 feet (4.5 meters).

The total FireWire cable length from the system 
to the last drive cannot exceed 236 feet (72 
meters).

Number of FireWire Drives

Digidesign has qualified configurations contain-
ing a maximum of four FireWire drives daisy-
chained to a Pro Tools workstation.

Either FireWire connector on the drive can be 
used to connect to the system and other drives.

To connect FireWire drives:

1  Attach a FireWire cable from either connector 
on the FireWire drive to a FireWire port on the 
computer. 

2  Daisy-chain any additional FireWire drives to 
the first FireWire drive.

FireWire Termination

FireWire drives do not require termination.

Connecting FireWire drives

power cables
to gounded

power source

second
DigiDrive

FireWire

first
DigiDrive

FireWire interface
cable to Pro Tools workstation

daisy-chain cable
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Connecting Other FireWire 
Devices
If you need to connect other FireWire devices 
(such as a camera or video deck) in addition to 
your FireWire drives, you can ensure maximum 
performance by daisy-chaining all drives to one 
FireWire bus and any other devices to a second 
FireWire bus. 

Hot-Swapping FireWire Drives
You can connect or disconnect a FireWire drive 
without shutting down your computer.This is 
referred to as “hot-swapping” a drive.

Connecting a FireWire Drive

To connect a FireWire drive while the computer is 
running:

1  Do one of the following:

• With Pro Tools 6 and higher, you can leave 
Pro Tools running.

• With Pro Tools 5.x and lower, quit 
Pro Tools.

2  Connect the FireWire cable to the system and 
turn on the FireWire drive. 

The FireWire drive appears in the task bar as a 
HotPlug/Eject icon (Windows) or on the Desk-
top (Mac OS). 

Disconnecting a FireWire Drive

To disconnect a FireWire drive with Pro Tools 6 
and higher:

1  Choose Windows > Show Workspace. 

2  Select a drive (volume) in the Workspace 
browser. 

3  Choose Unmount from the Browser menu.

4  Turn off the FireWire drive and disconnect it 
from the computer.

To disconnect a FireWire drive with Pro Tools 5.x 
and lower:

1  Quit Pro Tools and make sure that all open ap-
plications are idle.

2  Do one of the following:

• In Windows, click the HotPlug/Eject icon 
on the right side of the taskbar and choose 
the FireWire drive you want to unmount 
from the pop-up menu.

• On Macintosh, drag the FireWire drive icon 
from the Desktop to the Trash.

3  Turn off the FireWire drive and disconnect it 
from the computer.

Computers with 2 FireWire ports do not 
necessarily have 2 FireWire busses. The 2 
ports may be on a single bus. (Refer to your 
computer manufacturer’s documentation 
for details.) Depending on your needs, you 
may want to add an additional FireWire 
bus card to your computer. 

Before you hot-swap a FireWire drive, be 
sure to unmount the drive and turn off 
power to the drive before disconnecting it 
from the computer. Failure to unmount and 
turn off the drive can cause damage or data 
loss.

Always use the Unmount command in the 
Workspace browser menu to unmount vol-
umes, or quit Pro Tools and then unmount 
the volume from the computer operating 
system. Do not use any other method to un-
mount a volume while Pro Tools is 
launched. 
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chapter 4

System Performance Guidelines

Pro Tools systems have strict hard drive require-
ments. The recording and playback perfor-
mance of your system depends on several fac-
tors.

For the latest information on Pro Tools drive re-
quirements and performance, refer to the Hard 
Drive Minimum Requirements in the Digidesign 
Compatibility documents at www.digide-
sign.com/compato.

Factors Affecting System Performance

Hard Drive Performance The faster the drive’s 
seek time and data transfer rate, the better. The 
data transfer rate required for 32-track, 24-bit 
performance (at a sample rate of 44.1 kHz) is 
4.04 MB per second of sustained throughput. 
This rate must be reflected in the performance 
of one or more of the drives (and for SCSI drives, 
in the SCSI subsystems in your computer) to 
achieve this level of performance.

Processor Speed The faster the computer’s pro-
cessor speed, the better. Overall system perfor-
mance can affect track count. 

DAE Playback Buffer Size Refer to the Getting 
Started Guide that came with your system for in-
formation on DAE Playback Buffer size and its 
effect on system performance.

Edit Density The number of edits per second af-
fects the number of times that a drive must seek 
to play audio. Sessions with higher edit density 
are more demanding on hard drives than ses-
sions with lower edit density. While most 
Pro Tools sessions have a low to moderate num-
ber of edits, extensive use of crossfades or pro-
cesses such as Beat Detective can create high 
edit density in a session.

Hard Drive Performance Tips

Use at least two drives You can improve perfor-
mance by allocating audio files between two or 
more hard drives. It is best to use drives that 
have similar performance characteristics.

Minimize cable length Do not exceed the maxi-
mum cable length for your drive type. Note that 
cable length includes the cabling inside the 
drive enclosures themselves—which can be up 
to 12 inches. 

• With SCSI Drives, the maximum cable length 
that can be used on a wide single-ended SCSI 
bus is 3 meters if you are using fewer than four 
devices, or 1.5 meters if you are using four or 
more devices. If you are running the drive in 
LVD mode, the maximum SCSI cable length is 
12 meters.

• With FireWire drives, each drive in the system 
must be within 14.76 feet (4.5 meters) of the 
next bus connector. The maximum total bus 
length cannot exceed 236 feet (72 meters).
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Keep audio files on one partition per drive Avoid 
distributing a session’s audio files over different 
partitions on the same drive, as this will slow 
drive performance.

Consolidate audio regions If you suspect that 
you are receiving poor drive performance due to 
high edit density, consider using the Consoli-
date Selection command in Pro Tools for 
heavily edited tracks. This will reduce the num-
ber of seeks required.

Keep sessions on the same drive type Do not 
spread sessions across different types of drives. 
For example, if your session has audio on a 
FireWire drive, you cannot also have audio for 
that session on a SCSI drive or an internal drive.

For details on consolidating audio and alloca-
tion of tracks to drives, refer to the Pro Tools Ref-
erence Guide.

Round Robin Disk Allocation in Pro Tools 
is not supported on systems with parti-
tioned hard drives.
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Drive Management for Windows XP

Initializing Drives
To prepare an audio drive for use with Pro Tools, 
you need to initialize it. In addition, you may 
want to periodically re-initialize the drives on 
your Digidesign system to improve overall drive 
performance.

When you initialize a drive, all data on the drive 
is permanently erased, and the partition map 
and directory structure are re-created. It is best 
to initialize drives when you are between 
projects, or when you are certain the media files 
and other data on the drives are no longer 
needed.

Partitions on Audio Drives

Windows drives require at least one partition. 
You can format your entire audio drive to con-
sist of one partition, or you can create multiple 
partitions on a single drive as a way to manage 
files and projects.

Pro Tools does not require specific partition 
sizes, so a range of partitioning schemes are pos-
sible. However, while creating multiple parti-
tions can improve drive performance with com-
plex sessions (when the session is contained in a 
single partition), small partitions can limit the 
size of audio files and sessions.

Choosing a File System

Pro Tools on Windows XP supports the NTFS 
and FAT32 file systems. In most cases, NTFS is 
recommended. 

The Windows XP Disk Management utility lim-
its FAT32 partitions to a size of 32 GB. If your 
drive is larger than 32 GB, either create multiple 
FAT32 partitions smaller than 32GB, use the 
NTFS file system, or use a partitioning applica-
tion such as PartitionMagic® to create partitions 
larger than 32 GB. 

Initializing a drive destroys all the data on 
the drive. Make sure you back up all critical 
data on a drive before you initialize it.

If you plan to connect your drive to a 
Mac OS X system, you may want to use 
FAT32. Mac OS X will mount a FAT32 
drive, allowing you to transfer your files to a 
Mac OS drive (HFS or HFS+) for playback.
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To initialize a drive in Windows XP:

1  Right-click My Computer and choose Manage 
from the pop-up menu.

2  Under Storage, click Disk Management.

3  Select the drive you want to initialize by click-
ing its disk number at the bottom of the Disk 
Management window. 

4  Make sure the disk appears as a Basic Disk. If 
the description of the drive under the drive 
number appears as “Dynamic,” right-click the 
disk number and choose Convert to Basic Disk.

5  Choose Action > All Tasks > Initialize Disk. 

6  Click in the disk partition map for the drive 
you just initialized. 

7  Choose Action > All Tasks > New Partition.

8  In the Partition Wizard, select Primary parti-
tion and click Next. Do not create an Extended 
partition for use with Pro Tools. 

9  Enter the size of the partition you want to cre-
ate and click Next.

10  Assign a drive letter to the partition, and 
click Next.

11  Choose a format for the partition (NTFS is 
recommended). 

12  Set the Allocation Unit Size to 32K. 

13  Enter a name for the new volume, and click 
Next.

14  Click Finish to create the partition. The 
progress of the formatting is shown in the parti-
tion map for the drive.

15  If you are creating more than one partition, 
click the unallocated portion of the partition 
map for the drive and repeat steps 7–14 for each 
partition.

After formatting is complete, each partition on 
the drive appears in the My Computer window 
with its associated drive letter and volume 
name.

Disk Management window

Converting to Basic disk

Clicking in the partition map

Choosing a format
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Tuning SCSI Drives
DigiDrive Storage Manager is a utility for tuning 
and testing Avid SCSI drives. DigiDrive Storage 
Manager will only work with Avid and Digide-
sign brand SCSI drives. It will not tune FireWire 
or IDE/ATA drives.

To tune a drive for Windows XP:

1  Launch the DigiDrive Storage Manager Setup 
application, located in the DigiDrive Utilities 
folder on the Avid Storage Utilities CD-ROM. 

2  Follow the on-screen instructions to install 
the DigiDrive Storage Manager application in 
the Pro Tools Utilities folder on your system 
drive. 

3  Double-click the file named DSM to launch 
the Digidrive Storage Manager application.

4  In the Storage Manager main window, click 
the Tune button in the side toolbar. This opti-
mizes the mode pages of all connected Avid and 
Digidesign SCSI drives for use with Pro Tools. 

5  Quit the Storage Manager application. 

Checking Drives
To keep your hard drive in peak operating con-
dition, you should perform maintenance checks 
on a regular basis.

Checking and Repairing Drives

Windows XP includes a utility for checking and 
repairing drive directory structure. 

To check a drive on Windows XP:

1  In the My Computer window, right-click the 
drive and choose Properties from the pop-up 
menu. 

2  Click the Tools tab, and click Check Now.

3  Select the “Automatically Fix File System Er-
rors” and the “Scan for and Attempt Recovery of 
Bad Sectors” options, and click Start.

4  When the Check Disk process is finished, click 
OK. 

If you are getting disk errors that cannot be re-
solved through the use of the disk repair utili-
ties, it may be necessary to back up your data (to 
tape or another hard drive), re-initialize the 
drive, and restore the data.

Defragmenting Drives

In multitrack recording, audio tracks are written 
in discrete files, spaced evenly across the disk. If 
the space required to write a discrete file is not 
available in a single contiguous block, the file is 
broken up into several file fragments. The de-
crease in performance due to fragmentation is 
continuous and progressive. As you add new 
sound files and edit existing files, the hard drive 
becomes increasingly fragmented.

To correct fragmentation, use the Windows XP 
defragmentation utility or a third-party disk 
maintenance utility (such as Norton Speed 
Disk® or Executive Software Diskeeper®). These 
utilities reassemble file fragments and reorga-
nizes discrete files so they are contiguous. You 
should check and repair a drive before you de-
fragment it. 

While defragmentation utilities usually do 
not endanger the integrity of hard drive 
data, you should back up any critical data 
before defragmenting or reorganizing files 
and directories on your hard drive.
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Troubleshooting

Drive Does Not Appear in My Computer

When a drive does not appear:

1  Make sure the drive is properly connected to a 
power source and turned on. 

2  Make sure all the drive cables are properly 
connected and secured in place.

3  With SCSI drives, make sure each SCSI bus is 
properly terminated. See Chapter 2 and 
Appendix A for information on the correct ter-
minator to use with the drive configurations on 
your system.

4  With SCSI drives, make sure each drive on a 
SCSI bus has a unique SCSI ID. If you have drives 
with duplicate IDs on the same SCSI bus, one or 
both of the drives might not appear on the desk-
top. See “Assigning SCSI IDs” on page 12. 

5  Restart the Digidesign system for the changes 
to take effect.

Drive Produces Errors

When a drive is producing errors or is acting 
unpredictably during playback or recording:

1  Run the Windows Disk Check Utility to repair 
any directory problems.

2  If you still experience problems, run a disk 
utility application (such as Norton Disk Doctor) 
to fix any bad block, folder, and file problems.

3  If possible, copy all the data on the drive to 
another location, initialize the drive, and restore 
the data.

System Fails to Start

On systems with SCSI drives, a SCSI bus error 
may cause the system to freeze on startup. 

If the computer fails to start, do the following:

1  Turn off the computer and make sure all 
Digidesign cards and the SCSI host bus adapter 
card are properly seated.

2  Check that all SCSI devices on the bus have a 
unique SCSI ID. Duplicate SCSI IDs cause system 
problems.

3  Make sure all SCSI cables are properly con-
nected.

4  Check that the SCSI bus is properly termi-
nated, as described in Chapter 2.

5  Turn on the computer.

6  If the system still does not start, disconnect all 
SCSI drives and restart the system. If the system 
starts without any drives connected, a drive, a 
cable, or a SCSI terminator might be defective.

7  Refer to the installation instructions that 
came with your Digidesign system for addi-
tional troubleshooting information.

With SCSI drives, before making any 
changes to cable connections or termina-
tion, shut down the Digidesign system and 
turn off all of the drives on the SCSI bus.
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chapter 6

Drive Management for Macintosh

Initializing Drives
To prepare an audio drive for use with Pro Tools, 
you first need to initialize it for your version of 
Mac OS. In addition, you may want to periodi-
cally re-initialize the drives on your Digidesign 
system to improve overall drive performance.

When you initialize a drive, all data on the drive 
is permanently erased, and the partition map 
and directory structure are re-created. It is best 
to initialize drives when you are between 
projects, or when you are certain the media files 
and other data on the drives are no longer 
needed.

Partitions on Audio Drives

Mac OS drives do not need to be partitioned for 
use with Pro Tools. While creating multiple par-
titions can improve drive performance with 
complex sessions (when the session is contained 
in a single partition), small partitions can limit 
the size of audio files and sessions.

To initialize a drive on Mac OS X: 

1  Launch the Disk Utility application, located in 
Applications/Utilities.

2  Click the Erase tab. 

3  Select the drive you want to initialize in the 
column on the left side of the window. 

4  Choose the format for the drive from the Vol-
ume format pop-up menu. Mac OS Extended 
(HFS+) is recommended. 

5  Type a name for the new volume. 

6  If you plan to connect the drive to a Mac OS 9 
computer, select Install Mac OS 9 Drivers. 

7  Click Erase. 

The drive appears on the Desktop with the new 
volume name. 

Initializing a drive destroys all the data on 
the drive. Make sure you back up all critical 
data on a drive before you initialize it.

Disk Utility (Mac OS X)
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To initialize a drive on Mac OS 9:

1  Install the ATTO ExpressPro-Tools applica-
tion, found on the Pro Tools Installer CD-ROM.

2  Launch ATTO ExpressPro-Tools. 

3  Select the drive you want to initialize in the 
Buses and Drives list on the left of the window.

4  Choose Utilities > Create Standard Volume.

5  Type a new name for the volume.

6  Under Mode Page Optimization, select Do Not 
Optimize.

7  If you want the new volume to have HFS+ for-
mat, select Mac OS Extended. 

8  Select the Install Driver and Initialize options. 

9  Click OK. 

The drive appears on the Desktop with the new 
volume name.

Tuning SCSI Drives
DigiDrive Storage Manager (Mac OS X) and 
DigiDriveTuner (Mac OS 9) are utilities for tun-
ing Avid SCSI drives. These utilities only work 
with Avid and Digidesign brand SCSI drives. 
They do not tune FireWire or IDE/ATA drives.

To tune a drive for Mac OS X:

1  Launch the DigiDrive Storage Mgr installer, 
located in the DigiDrive Utilities folder on the 
Avid Storage Utilities CD-ROM. 

2  Follow the on-screen instructions to install 
the DigiDrive Storage Manager application in 
the Pro Tools Utilities folder on your system 
drive. 

3  Double-click the file named DigiDriveStorage-
Manager.

4  In the Storage Manager main window, click 
the Tune button in the side toolbar. This opti-
mizes the mode pages of all connected Avid and 
Digidesign SCSI drives for use with Pro Tools. 

5  Quit the Storage Manager application. 

To tune a drive for Mac OS 9:

1  Locate the DigiDriveTuner application, in the 
DigiDrive Utilities folder on the Avid Storage 
Utilities CD-ROM, and drag it to the Pro Tools 
Utilities folder on your system drive.

2  Launch the DigiDriveTuner application.

When DigiDriveTuner detects an Avid or 
Digidesign SCSI drive, it automatically opti-
mizes the drive’s mode pages for use with 
Pro Tools.

ATTO Express-Pro Tools (Mac OS 9)

Create Standard Volume Options
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Checking Drives
To keep your hard drive in peak operating con-
dition, you should perform maintenance checks 
on a regular basis.

Checking and Repairing Drives with 
Disk First Aid

Disk First Aid is a drive directory structure repair 
tool that is supplied with the Mac OS operating 
system. Disk First Aid can find and repair many 
basic directory structure problems to help keep 
your drives functioning properly. 

Use Disk First Aid when your system is reporting 
drive errors or when files on the drive cannot be 
opened and used by Digidesign software.

Running Disk First Aid

Follow the instructions that follow for your ver-
sion of Mac OS. 

To run Disk First Aid on Mac OS X:

1  Launch the Disk Utility application, located in 
the Utilities folder inside the Applications 
folder.

2  Click the First Aid tab.

3  Select the drive you want to verify or repair in 
the column on the left side of the window. 

4  Click Repair Disk to verify and repair the 
drive. 

5  Quit the Disk Utility application.

To run Disk First Aid for Mac OS 9:

1  Launch the Disk First Aid application, located 
in the Mac OS 9 Utilities folder. 

2  Select the drive you want to verify or repair 
from the drive icons at the top of the window. 

3  Click Repair to verify and repair the drive. 

4  When you are finished, choose File > Quit to 
quit the application.

Run Disk First Aid regularly as a proactive 
method of avoiding drive problems.

Disk First Aid (Mac OS 9)

Disk First Aid (Mac OS 9)
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Using Norton Disk Doctor

Norton Disk Doctor is a third-party application 
for diagnosing and repairing drive problems 
that is available for Mac OS X and Mac OS 9. 
Norton Disk Doctor provides more comprehen-
sive coverage of drive problems than Disk First 
Aid, and can repair directory structure and file 
problems that Disk First Aid cannot repair.

To use Norton Disk Doctor, you can install 
Norton Utilities® onto one or more of the drives 
on your system, or you can run it from the 
Norton Utilities CD-ROM. 

Repairing Drives with Norton Disk 
Doctor

To repair a drive:

1  Launch the Norton Utilities application.

2  Choose Norton Disk Doctor from the Norton 
Utilities Main menu. 

3  Follow the Norton Disk Doctor instructions 
for drive repair and recovery. Try to fix all of the 
problems noted by Norton Disk Doctor.

4  After you are finished, run Norton Disk Doc-
tor a second time to make sure the repairs are 
complete.

5  Quit Norton Utilities.

Defragmenting Drives

In multitrack recording, audio tracks are written 
in discrete files, spaced evenly across the disk. If 
the space required to write a discrete file is not 
available in a single contiguous block, the file is 
broken up into several file fragments. The de-
crease in performance due to fragmentation is 
continuous and progressive. As you add new 
sound files and edit existing files, the hard drive 
becomes increasingly fragmented.

To correct fragmentation, use a disk mainte-
nance utility (such as Norton Speed Disk), 
which reassembles file fragments and reorga-
nizes discrete files so they are contiguous. You 
should check and repair a drive before you de-
fragment it. 

If you install the Norton Utilities applica-
tion, perform a custom installation to load 
only the Repair and Recovery utilities and 
the Startup Disk Builder. Other Norton Util-
ities programs can cause conflicts with 
Digidesign software. 

After using Disk First Aid or Norton Disk 
Doctor to repair a drive or recover data, 
Digidesign recommends that you back up 
the data and reinitialize the drive as soon as 
possible.

While defragmentation utilities usually do 
not endanger the integrity of hard drive 
data, you should back up any critical data 
before defragmenting or reorganizing files 
and directories on your hard drive.
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Troubleshooting

Drive Does Not Appear on the Desktop

When a drive does not appear:

1  Make sure the drive is properly connected to a 
power source and turned on. 

2  Make sure all the drive cables are properly 
connected and secured in place. See Chapter 2 
for cable and setup information.

3  With SCSI drives, make sure each SCSI bus is 
properly terminated. See Chapter 2 and 
Appendix A for information on the correct ter-
minator to use with the drive configurations on 
your system.

4  With SCSI drives, make sure each drive on a 
SCSI bus has a unique SCSI ID. If you have drives 
with duplicate IDs on the same SCSI bus, one or 
both of the drives might not appear on the desk-
top. See “Assigning SCSI IDs” on page 12. 

5  Restart the Digidesign system for the changes 
to take effect.

Drive Produces Errors

When a drive is producing errors or is acting 
unpredictably during playback or recording:

1  (Mac OS 9 systems only) Rebuild the drive’s 
Desktop file by restarting the computer and 
holding down the Option and Command keys 
during startup, then clicking OK when the sys-
tem prompts you to rebuild the desktop for each 
mounted drive.

2  Run Disk First Aid to repair any directory 
problems.

3  If you still experience problems, use a third-
party disk utility application (such as Norton 
Disk Doctor) to diagnose and fix any bad block, 
folder, and file problems.

4  If possible, copy all the data on the drive to 
another location, initialize the drive, and restore 
the data.

System Fails to Start

On systems with SCSI drives, a SCSI bus error 
may cause the system to freeze on startup. 

If the computer fails to start, do the following:

1  Turn off the computer and make sure all 
Digidesign cards and the SCSI host bus adapter 
card are properly seated.

2  Check that all SCSI devices on the bus have a 
unique SCSI ID. Duplicate SCSI IDs cause system 
problems.

3  Make sure all SCSI cables are properly con-
nected.

4  Check that the SCSI bus is properly termi-
nated, as described in Chapter 2.

5  Turn on the computer.

6  If the system still does not start, disconnect all 
SCSI drives and restart the system. If the system 
starts without any drives connected, a drive, a 
cable, or a SCSI terminator might be defective.

7  Refer to the installation instructions that 
came with your Digidesign system for addi-
tional troubleshooting information.

With SCSI drives, before making any 
changes to cable connections or termina-
tion, shut down the Digidesign system and 
turn off all of the drives on the SCSI bus.
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SCSI Cables and Terminators

SCSI Cables

Use only the highest quality SCSI cables available when connecting a SCSI drive to your Digidesign 
system. Digidesign recommends the use of SCSI cables manufactured by Avid. These cables are spe-
cifically designed for systems that run real-time applications, and their lengths and electrical proper-
ties are designed to ensure data integrity on the SCSI bus. These cables are described in Table 1. 

Table 1. SCSI Cables

Cable Type Length Purpose

Macintosh system 
built-in SCSI to first 
narrow drive

25-pin to 50-pin 30 inches To connect the first narrow drive to the Macin-
tosh external SCSI bus.

SCSI accelerator 
board to first drive

68-pin to 50-pin 30 inches To connect the first narrow drive to the Digide-
sign SCSI bus. Use only on SCSI buses that con-
tain no wide drives.

68-pin to 68-pin 30 inches To connect the first wide drive to the SCSI bus 
or a single-channel SCSI accelerator board.

60-pin to 68-pin 30 inches To connect the first wide drive to a dual-channel 
SCSI bus.

SCSI cabling 
between drives

50-pin to 50-pin 15 inches To connect vertically stacked narrow drives.

50-pin to 50-pin 30 inches To connect side-by-side narrow drives.

68-pin to 68-pin 15 inches To connect vertically stacked wide drives.

68-pin to 68-pin 30 inches To connect side-by-side wide drives.
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SCSI Terminators and Adaptors

The Pro Tools SCSI chain must be properly terminated or your system will not function properly. 
Only the last device on the chain should be terminated. Depending on the configuration of your 
drives, you will need one of several different types of SCSI terminators and adapters to cover the vary-
ing style of connectors found. These are illustrated in Table 2. 

Digidesign recommends the use of SCSI terminators manufactured by Avid. These color-coded termi-
nators are specifically designed to ensure data integrity on the SCSI bus for systems that run real-time 
applications. Avid terminators are available through your Digidesign dealer.

You need to connect an ultra, wide-to-narrow SCSI adapter to change from 68-pin cabling to 50-pin 
cabling. The adapter terminates the unused lines to help prevent any SCSI bus problems.

Table 2. SCSI Terminators and Adapters

Type Style Description

50-pin terminator Fast, narrow terminator for SCSI buses that have only 
narrow drives (purple).

50-pin terminator Ultra, narrow terminator for SCSI buses that have a 
mixture of wide and narrow drives (blue).

68-pin multi-mode 
terminator

Ultra, wide terminator for wide drive SCSI buses which 
run in LVD or Single-ended mode (blue).

68-pin to 50-pin 
adapter

Ultra, wide-to-narrow terminating adapter for connect-
ing wide and narrow drives (blue).
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Maximum Configurations

Table 3 lists the maximum number of LVD drive enclosures that can be connected in various config-
urations.

If you increase the length of the cables listed below, you must reduce the number of drives in the 
chain.

Table 3. LVD Drive Configurations

Number of LVD Enclosures
Cable Length from 

Host System to 
First Drive

Cable Length 
Between Drives

Comments

15 LVD enclosures 30-inch 15-inch This configuration uses the 
maximum number of LVD 
drives but requires that the 
cable lengths be at a mini-
mum.

10 LVD enclosures 10-feet 30-inch This configuration provides a 
greater distance between the 
host system and all the 
drives.

8 drives 
(any combination of LVD 
and single-ended)

30-inch 15-inch or 30-inch This configuration includes 
LVD and single-ended drives.



Pro Tools Storage Guide36



Appendix B: Customer Service and Technical Support 37

appendix b

Customer Service and Technical Support

Warranty Information
Your Avid Drive has a 5-year warranty, and if it 
fails in that time period, Digidesign will re-
pair/replace the unit for free. In the event of a 
failure which requires repair or replacement, 
Digidesign is not responsible for the recovery or 
replacement of any data which may be lost as a 
result of the failure. 

For complete warranty information, refer to the 
Avid documentation included with your Avid 
drive. 

Warranty Product Service

Customers needing warranty service should 
contact their regional Digidesign support center 
to troubleshoot, confirm product failure, and 
obtain a return authorization number. In most 
cases, repair of replacement will take place 
within 48 hours of receipt of the product. 

Digidesign will return the product, postage pre-
paid, during the next business day through a 
suitable carrier to the address specified within 
the return authorization (directly to the cus-
tomer or dealer). Rush charges depend on prod-
uct size and weight. 

Non-Warranty Product Service

Customers needing non-warranty service 
should contact their regional Digidesign sup-
port center to troubleshoot, confirm product 
failure, and obtain a return authorization num-
ber. In most cases, repair of replacement will 
take place within 48 hours of receipt of the 
product. 

Acceptable forms of payment for non-warranty 
service are Visa, American Express, MasterCard, 
or approved company purchase order number 
(North America only). Payment by check is ac-
ceptable if drawn on U.S. funds. 

Shipping Instructions for Product Repair 
Service

After obtaining an return authorization num-
ber, defective products should be shipped with 
transportation and insurance charges prepaid to 
the repair center in your area:

US/Canada:

Digidesign (reference RA #)
Customer Service
3885 Bohannon Drive
Menlo Park, CA 94025 USA

Europe/Japan/Australia/South Pacific:

Please contact your local Digidesign Customer 
Support office for shipping instructions. 
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Technical Support

Warranty Support

As an owner of an Avid drive, you are eligible for 
complimentary technical support from Digide-
sign for 5 years from the date of original pur-
chase. In the event that you need technical sup-
port or if you need to contact a Digidesign 
office, please refer to or visit the Digidesign Web 
site (www.digidesign.com). 

Non-Warranty Support

Customers in the United States and Canada 
seeking telephone support for a product that is 
past warranty should call the Digidesign 
ProAxess™ Line, a priority support service 
where customers speak with a senior technical 
support representative. International customers 
should call their regional support office. For 
contact information, please refer to or visit the 
Digidesign Web site (www.digidesign.com). 

How to Contact Digidesign

Digidesign World Offices

Digidesign:
2001 Junipero Serra Blvd
Daly City, CA 94014-1976
8:30am-5pm PST Mon.-Fri.

France:
33-141-49-40-10 Main
33-147-57-56-28 Fax
10-6 Mon.-Fri. 

Mexico/South America:
(52)5485-1139 Main
(52)5033-8027 Fax
latinamercs@digidesign.com
9-5 Mon.-Fri.

North America:
650-731-6300 Main
650-731-6399 Fax
8-5 Mon.-Thur.; 8-3 Fri.

Germany:
49-811-5520-555 Main
49-811-5520-599 Fax
10-6 Mon.-Fri.

United Kingdom:
44-1753-653322 Main
44-1753-658501 Fax
10-6 Mon.-Fri.

Australia/South Pacific:
613-9499-3535 Main
613-9499-3535 Fax
11-7 Mon.-Fri.

Italy:
39-02-577897-81 Main
39-02-577897-25 Fax
10-6 Mon.-Fri.

EMEA (Europe, Middle East 
& Africa):
44-1753-658-496 Main
44-1753-658-501 Fax
10-6 Mon.-Fri.

Benelux:
31-73-613-8080 Main
31-73-612-2044 Fax
10-6 Mon.-Fri.

Japan:
81-3-3505-4762 Main
81-3-3505-3417 Fax
10-6 Mon.-Fri.

Spain:
34-932-311978 Main
34-932-311658 Fax
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Digidesign Services

Service Contact Information Availability

End User Warranty Support & 
Customer Service 
Administration

650-731-6100 (voice)

650-856-4275 (fax)

8 am - 5 pm
Mon-Thur (Pacific Time)
8 am - 3 pm
Fri (Pacific Time)

Any time

ProAxess Line
(Priority Support)

888-344-4376 (US only)

900-555-4376 (US only) 

8 am - 5 pm
Mon-Thur (Pacific Time)
8 am - 3 pm
Fri (Pacific Time)

Digidesign Web site www.digidesign.com Any time

Digidesign User Conference duc.digidesign.com Any time

Technical Support Email www.digidesign.com/tsr   Any time

Customer Service Email csadmin@digidesign.com Any time
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